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URBAN ENVIRONMENTAL ENGINEERING
ULSAN INSTITUTE OF SCIENCE AND TECHNOLOGY

Impact of New Metro Line on Nearby Housing Price

: Gangseo gu, Seoul

Jeong jtheon', Kim jeongsud®
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Introduction

TOD(Transit-Oriented Development)

Urban rail transit has been widely considered an efficient and environmentally
friendly mode of transport to address deteriorating urban transportation
conditions.{Diao et ol. 2015)

100 has the potentidl to provide s comprehensive alternative to the
automobileBemick and Cervero, 1997).
ggiambMOMWNmMMdmmCmﬂﬂt

).

Seoul Metro Line 9
)

2015.0328

Result & Condusion

Regression Analysis of each model is done by STATA 14.0 (StatsCorp, Texas, USA)
Linear - SP is dependent variable / Semi log : In/SP) is dependent varlable

<Result of Regression Analysis>
Gangseo-gu o od
4 b} .
A Proparty Charactevistics'P)
E SPACE 0 [T 001 oo
TOTALFOOR | od1s™ aare 0.0 o™
‘a LOW_FLOOR 2710 2745 021 0.7
,( AGE 0518 0802 a2t o000
- AGESQUARE o1 0,009 000" 0.000
— . APTSZE 0.001" .00 2000 0.000
N New & Aremative Transtt Mode Locationa] Chavacseristicsfl)
- Adtove 700 Development EXPRESS 0,360 2640 Q03 0.055"
- Magok New Town PARK 7 1081+ s Qe
o= \ JI | [mvem 0.0598" 1295 [T 0030
| = Y i / Time
b as TRENDALL 0,007 0,005 2003 0.002
Research Objective — . e e e
impact of new metro ine 9 on nearby housing price by each period is estimated. Tn anr 0204 200 2001
Showing positive impact of new TOD an Mousing Price, synergetic relotionhip b ™G o o Py 0
TOD ond Pedestrian environment is revealed. 0D Eftect
\, 1009 500 0604 [ a0 0.085
009500 TIMEI | 0.788* 062" 0.006" 0004
Method [TOD9 500.TiMez | 173" asie 00H* 01
Nate *, %%, %% rfen o graficece & e 010, 064, 001 leve!, rapectively
Data > ACCording 1o the satisical signifcances of coefiient, Model 2(Muln Leve Linear Model i the
Totad 2971 Transactions in 161 Apartments frem 200601 1o 201506 : MOLIT s sale database mest model 10 fnal analyss
Housing Price Index(200601 1o reterence, 100 : Karea Appraisal Board Property Characteristes(P)

Reference Real Estate information : NAVER Real Estate
Hedonic Price Model & DID (Difference-in-Difference)
SP =By + B*P+ B'L + B'TRENDALL+ B, *TRENDI « B,*TREND2 + f,*TODS 500
+ B, TIMET + B *TIMEZ + §,°TODS_ SO0°TIME1 + §,°T0DS. S00°TIMEZ+ ¢

SP(Sal Price) |un_qum-g!uwummo dent Varable)
Propecty OevacawistioP)

SPACE Area of exclusive use of housing unit (W) in an apartment

TOTAL AOOR | Total Floor of & housing unit

LOW FLOOR | First floor « 1|, Otherwise « 0

AGE Building Age

AGESQUARE | Square of the AGE

APTSIZE Total numbsr of housing unts in an apanment

Coufficienss of 2 variables in this category examine well about the relationship between housing
e and sach variabie, ax we apected

Locations/ Characteristicsit)

PWhathey the mearest stetion /s enpvess station ar not alfect greatly oo housing poice. Near express

station posthwly affect on Nousing price. And alsa, the acorssdviises 1o peghbarbood park and
A iver dre impoviant fackors (0 neaity howsing price

700 Effect
Bus  AfarSaction ! « Befre Section 2 Ater Sacion 2
KoLK 10 KoLsm  13m
'wtf:"" "ﬁ;‘” TvEr 024 iz et
1004 500 IME! 0829 1009 500 TME2 - 018
Totw
ey 168(+0428) 1810224

i the periodd IAfter Section 1~ Before Section 2, housing price within TOD sve(S00m) increases as
425%. In contast result about the period YARw Section 2 is negative, Mouslng price decredses a5
222N, Becauie perlodd i tevms of “TINES vanriabie s 100 short( 01504 - X01S06), quantity of data may
MO0 avaew i fepvasent this peviod weill If the fonger peciod in e of TINEZ' is longes, resdt

about section 2 will show the positive impact of Section 2 apening on Aousing price.
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Monocular Vision-based Displacement Measurement System
Robust to Angle and Distance using Homography

WJrisT

Jun-Hwa Lee

Displacement is Comparison between Disp. Measurement Devices

@ Direct output generated by Input force acting to & structure ~ e ——

0 Important element In design process and defining system behaviers

8t popuiarty uiee for Sk due to ficulty on several s \ /‘ X\‘ "
Issues on Displacement Measurement 1. Accepeabie sccuracy

* Acaplable accumey 2. Cast eftectiveness ‘Q’Q\.‘o

+ Costeffectivensss

 Chomaiis 1. Convenlent frstatiation ® ) (-] (<]

* Measurement capabliity for unreachabie polos Tidee (red e b aveschatie wunumm! (] l ® ] ] J (4]

decause of undemeath water flow
|
Hardware Components Algorithm Components Software made by MATLAB
1. Marker -
" Overss sgortm "
¢
.'!
“‘ Lam;t::m we A' . ‘ﬂ
J -
.mn« lmne
Overall handware configaration f 2
Components & Features ',:“'-'4' e
i | Developed real time dsplacement measurement
1 Narker program in MITLAR languge
ECASHIChIN s S84 e og pniion Homoera * Two major flow: Centrold tracking of the feature

* Nahers movementeStructune’s mavement

] |2 Camera
¢ Locate 3t the measurement point
w.i

* Capture Image sequence of marker

* Compuste real displacement from image displacement

LTSRN

poies and real diplacement caculation,

* Homography relationsni is established for 2oy two plane

ol gy l"'f‘n(-/lv 1»

. WMNN‘ have “" D
* Controld tracklng
* Aplane to plane mapping fn the same projective space >
* Marker Image & dutortad when camera ks lacated at ore side A process finding the centrokd coordinates for
£ach mage equence,

*+ Centrold tracking procews & conducted for 4

T reglon of interest (ROI) separately for facter

* Traneter anaiog cam. signal to PC as digtized cata * Momography computation processing

. m“ﬁ ’

: M. By * Real diplacement calcuiation

el Mo & A ~

g 1 Ia A Al :Mm ahy b calculated at the first image

* Process captured ata o find image diplacement In * Homography matrix (M) has § degree of fraadom (D0F) o

the image sequerce + 8 equation (4 cormesponding pate) Ik required to saive ¥ Real displacement b calculated by taking inverse

mduplication of hamography matrt to centrokd
of a feature paine.

¢ Vision-based approach B 5.0 milimeter accuracy, coat effectie, convenience
Iretaliation, and high applicabiiity on Large structures

Time (se<)

¢ ArdRrary camend location & offered by employing homography and aptical
200m adjutment
* ncrease feasRiiRty for the large structures that has few option for camena
location

¢ Agvance performance In teams of accuracy and sampling rate ¥ espected by
employing faster Sandwidth intertace
+ Bxample : USB1.0 (623B/s), CoaXpress (S00MB/s), Camera Link (680MB/4)

Results In time series (45t « 20m, angle « 603eg.)

o
o oo References
% q -
4 ‘7‘ ams e v ™18y =By ) . A a
¥, N k) LR Y F A Clang € C (2008) Nowtrget siares v dechesgue for spuisnianpend ropome
«‘ ) ] / » manrenat of melhe enclae o o expmeemg sechan s, LA, dond 4
s // w— ] Dolee, ! ) & Shrecda M (206 A vabeed meas for remcle sooeg of nge
’ Poos . ohg dopluement N £ Smemanonal -4, 25441
' w S e % » ~v ) Cueg € C, & X X K 006 Thesodmenens sracsed tursialion e e
\ WA 0000 ™ / - | ‘.,.Mv nasrene g Tesccile adogtermany Jowrna of egmerayg mechanes, 16, 8-
M\" Distance sl LN . | prs m; W
' - ~ - v_‘ 4 Fohuk Y Fayg M Q Nesin ¥, Kaneho 8k Tonda T Q001) Visrnbased dnplacenens
Y | m" wanr for Sy roqunie weng wboat uhet warch slpntm Swen Jomal
. = ESE 20 4T84
Camena Ervor for each cases S Sege MO 2004) Sarvey seer mage Boedeidey lecheaues asd quasiialve poderaese
onduatn Jowmal of Slestmer mopng 11, 145108
* Propased system has great agreement with LDV, which :
Overview disgram Mmeasires QlEplacement In MCTOMELEr ACCLIICY Sven . "'":”‘: & Ko, A, (005 Walighs viow ey 8 sumpule; s, Cninidys
) e

(Experiment varfable « angie, dlstance)

hough angle and JHIANCE was consideradly changed.
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[Urban and Environmental Engineering] Spring 2020 Interdisciplinary Project Guidelines
1. For whom

- Students whose 1%t track is UEE registered in the course “Interdisciplinary Project” this

semester for graduation, including early graduation

2. Overall Schedule

Contents Date
Application through portal 2020. 03. 20. (Fri)
Project period During Spring 2020 semester
Submission of Project Poster 2020. 05. 25.(Mon)

Submission of Project Report
) 2020. 05. 25.(Mon)
(For evaluation)

Presentation of Project 2020. 06. 05.(Fri) 2 p.m.

3. Application Procedure
1) Both students whose first track is UEE(OLD) and UEE(NEW)
- Contact professors in advance for nomination of directors.
- Apply for the project through portal (Enter both advisors’ names and project proposal)
2) For students whose firs track is UEE(OLD)

- Register for Interdisciplinary Project Courses from both 15t and 2" track

4. Evaluation of Project

1) Completing report of project after planning and conducting the Project during the

semester having discussion with two advisors
2) Uploading the report : Portal — Course — Interdisciplinary Project — File
3) Request for evaluation to the advisor and the co-advisor respectively
4) Two advisors provide you with one of A, B, C, F

(A, B, C: Pass / F: Fail)

-> You are able to pass and get the credits only if both of two advisors give you the

score of PASS



5. Submission and presentation of Poster
-> You could get the credits attending poster presentation after submission
1) Form of the poster : After making it 1 sheet of PPT file, transform it to PDF file
(Width 70CM * Length 90CM)

-> Submission : To minsun4567@unist.ac.kr

-> Once it is submitted, there's no way to fix, so submit it after reviewing from advisors.
-> Designation of the file name : “Interdisciplinary Project Poster_ Name(Student #)

2) Due date of submission : 05.25.(Mon)

-> You yourself should make the poster if you don't submit on time.

3) Poster Presentation : 06.05.(Fri) 2 p.m. / 1f lobby between bldg.108 and 110.

4) Example of posters (Next page)

6. Report

1) Over 100 words in English for each section

2) Letter point : 11 / Font : Times New Roman / Color : Black
(Figures or pictures can be colored)

3) References : Choose one among ACS, AMS, APA, IEEE, Harvard; ACS is recommended
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< Poster of Ji-hoon Jung>

URBAN ENVIRONMENTAL ENGINEERING
ULSAN INSTITUTE OF SCIENCE AND TECHNOLOGY
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Impact of New Metro Line on Nearby Housing Price

: Gangseo gu, Seoul

Jeong jtheon', Kim Jeongsud®
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Introduction

TOD(Transit-Oriented Development)

Urban rail transit has been widely considered an efficient and environmentally
friendly mode of transport to address deteriorating urban transportation
conditions.{Diao et ol. 2015)

TO0 has the potentidl to provide a comprehensive alternative to the
automobile(Bemick and Cervero, 1997).

10D is a way to reduce driving and redress outo-related problemsiCervera et al.
2002).

Seoul Metro Line 9
I

2015.03.28

Section 1

Gangseo-gu

Result & lusion

Regression Analysis of each model is done by STATA 14.0 (StataCorp, Texas, USA)
Linear : SP is dependent varable / Semi log : in/SP) is dependent varlable
<Result of Regression Analysis>

Model | Model 2 Model 3
(OLS Unear)  (Multh-Lovel Linear)  (OLS Semi-log)

Model 4
M- Lewel Somi-log)

A { : Before Property ChasacteristicsdP)
l - P SPACE 0.358% 0.328% 0.014** 0.0n
\. —— High Dependency on Bus TOTAL FIOOR YT A 2o Do
‘a LOW_FLOOR 2710 2745 0.21° .07
,( T ‘ AGE o 0602 Q021 0,020
YN ; After AGESQUARE a013** 0.009** 0.000** 0.000'*
—als \| | [aersee 0.003 0.003* 0,000 0,000
. New & Azemative Transit Mode s ey e
——— l Active 700 Development (EXPRESS 0360 260 a0 0055
.:. ) Magok New Town J PARK L7 10930+ 0084 Q068"
o= RIVER 00598 1295 [T 0.030*
- — i Time
. . TRENDALL 0.007°* 0.0094 20034+ 0.002+%
Research Objective — ~rm e A O
Analyzing with Medonic Price Model and DID(Difference-in-Difference), tempoaral TREND2 0382 0.405%" 0.003* 000
impact of new metro line 9 on nearby housing price by each period is estimated. TIME e D204 a0 2001
Shewing positive impoct of new TOD on Meusing Price, synergetic relotionship b TIME2 10 138 0.026* 0039
100 ond pedestry i reveated [7o0 erec
N T0D9 500 0604+ 1340 2042 0.085**
TODS_ 500 TIMEY | 0.788°* 0.629** 0.006* 0004
I R |
Nate %0, ¢ o o mgnficexe & e 000, 004, 001 level, ropeactively
Data > According o the o Mode! 2(Muln Leve Linear Model is the
Total 29711 Transactions i 161 Apartments from 200601 10 201506 : MOLIT s sale database mest sppropriate model 10 fnal analyss
Housing Price Index(200601 1o reference, 100} : Korea Appraisal Board Property Characteristics(P)

Reference Real Estate information : NAVER Real Estate
Hedonic Price Model & DID (Difference-in-Difference)
SP =By + B*P+ B,"L + B *TRENDALL+ B, *TRENDI! = B,*TRENDZ + f,*TODS 500
+ B,*TIMEI + B *TIME2 + B,TODS SO0*TIMET+ §,°TODS_ S00°TIME2+ ¢

5P Sale Price for the market trend Vanabl
| Property OharacaeisticsP)

SPACE Area of exc use of housing unit (me) in an apartment
TOTAL RLOOR | Total Floor of 3 housing unit

LOW FLOOR | First fioor « 1, Othermise « 0

AGE Building Age

AGESQUARE | Square of the AGE

APTSIZE Total numbsr of housing units In an ap

Conficents of 2l varables in this categery examine wwl about the relationsing between housing
e aod sach variabie, a5 we expected

Locationsl Characrerisocsil)

Whathey the peareit station /s exvess stabion ar not affect grestly oo housing poice. Near express

station positiwly atfect on housing price. And alsa, the acorssdviises 1o peghbarhood park and
M tiver are impoviant facsors 10 nearly housing price

70D Etfect
Bus  After Suction 1 ~ Refors Section 2 e Section 2
WONS0S 0 1009 500 3w
g ooy L0204 vz T
1003 500 TME 0529 1009 500 TME2 - 0916
Tota
e | 19 1265140428) 180228

ot the period IAfter Section 1 - Before Section Zi, housing price within TOD s/ SO0m) increases as

LT I conbrast result about the period JAfter Section 2 is negative. Mouslng price decieases a5

222N, Because parioxdt i tevms of “TIMEZ' variabie Is 100 svt(B0IS04 - X01S06), Quantity of data may

MOF anaNee o fapvasent this period weill If the fonger peviod in teems of TIMEZ' is longes, reslt
about section 2 will show the positive impact of Section 2 apening on Aousing price.




< Poster of Jun-hwa Lee>

Monocular Vision-based Displacement Measurement System
Robust to Angle and Distance using Homography

Jun-Hwa Lee

risT

Displacement is

@ Direct output generated by Input force acting to & structure
Qwu«mnmpmmnmmmsmm
@ Net popularly used for SHM due to difficulty on several lssues.

Issues on Displacement Measurement

Com

rison between Disp. Measurement Devices

Funcamental Device

GPibated  Vuiondased

\/mw

1. Accepeable sccurscy @
= Accapinble accomey 2. Cost effectivenes | . | Q | . ] °
* Cost-effect!
. mmm 3. Convenfent tretallation ® © ' o )
* Measurement capability for unreachabie palnt e e I I
Decause of undermeath water flow
Hardware Components Algorithm Components Software made by MATLAB

1. Marker

Qverail hardware conflgaration

Components & Features

1. Narker

 Attached on the measuring pasiticn
+ Markers Sructue’s

1 |2 Camera
* Locate 3t the measurement point
* Capture Image sequence of marer

1. Frame Gratber
= * Traveter anaiog cam. signal to PC as digitized caty
* Facliltate real time proces

4 Lapuep

* Process captured data to Mnd image displacement In
the tmage sequence

* Comprste real displacement from image displacement

Overdi dgorithm

Lere
Camera Aperture

i 5 |
:Mmulmneé
: ..‘,:‘

HPT S
"

Homogra is
¢ Marker Image and rexl

Developed real time dsplacement measurement
LOOG7 M 0 MTLAR Langage

N i

* Two major flow: Centrold tracking of the feature
poies and real dieplacement caiculation,

have

* Aplane to plane mapping in the same projective space
* Narker image & dusorted when camera s lacated at ore side
* Homography relationsnip is established for oy two plane

Inciuding Gzomed marker image
* Momography computation
=) T8 A ATl
whehe h, A, A i)

1A A A

5

* Homography matrix (M) has & degree of freadom (DOF)
8 £quation |4 corresponaing pole ) s required to salve M

1k vl «H i) < B aadmS)>

* Centrold tracking

¢ Aprocess finding the centroid coordinates for
each image sequence,

* Centrold tracking process & conducted tor 4
region of interest (RO1) separately for facter
processing.

* Real displacement calcutation

* Momograghy b calculated at the finst image
wene,

* Real cisplacement i caloulated by taking inverse
MUATPCATIon of homography Matrtx to centroks
of a feature paint.

122223429
Time jsec)

¢ Vision-based approach & S0 milimeter accuracy, cost effective, convenience
Iretaliation, and high applicabliity on Large structures
+ ArRrary camena location & oftered by empicying hamography and aptical
200m AchELment
* Increase feasRiifty for the large structures that has few option for camen
weatton

* Agvance performance In tenms of BCCUracy and sampling rate i espected by
employing faster Sandwidth interface
* Dample : USB1.0 (623WB/5), Coakpress (S00MB/3), Camera Link (680MB/5)

Resules In time series (dst. = 20m, angle « 603091

References
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* Proposed system has great agreement with LDV, which J
Overview diagram " e ACUracy even & Hutley, I, & Zseewen, A (201) Malple view geomatry = competar voios Cambndge

(Experiment varfabie « angie, dlstance)

though angle and dkwu was consideradly changed.
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FAQ
Nomination of two advisors

@ It is recommended that two advisors would be nominated from 1%t track and 2"

track respectively (One advisor is not acceptable)
@ It is possible that two advisors are nominated only under their agreement
-> You could get a “F" if there was no agreement of nomination

-> Application for nomination of advisors should be proceeded with the approval

Topic of Project
-> Interdisciplinary Project : Evaluation of report which has established for 4 years
@ Related to research in which you have worked on

Ex) Research you have worked on in the lab during the research internship period or the

research on going by the professor
@ Review of Thesis you are interested in

Ex) Review of thesis related to

Etc

1) Should | choose the advisor as the educational advisor? What about the advisor from
the 2" track?

- Students themselves need to choose 2 professors who could give you an advice on

the field of the project.

2) Should students whose are in old tracks write 2 reports since they get 2 credits from 2

tracks respectively?

- It would be the one report which will be evaluated by 2 professors. 2 credits would be

accepted for each track after evaluation.



